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1.目的

建立环境控制原子力显微镜 Cypher ES标准使用操作规程，使其被正确、规范地使用。

2.范围

本规程适用于所有使用环境控制原子力显微镜 Cypher ES的用户。

3.职责

3.1.用户：严格按本程序操作，发现异常情况，尤其是仪器故障时及时汇报实验室技术

员；隐瞒不报造成仪器进一步损伤将加重处理。

3.2.实验室技术员：确保操作人员经过相关培训，通过考核，并按本规程进行操作。

4.实验室安全管理规范

4.1.进入实验室的所有师生应熟悉消防安全基本知识、化学危险品安全知识、用电/用水/

用气常识。

4.2.严格遵守实验室的各项安全管理规范，注意警示标识。

4.3.实验室仪器需经培训考核后方可操作，并严格遵守仪器标准操作规程（SOP）进行

检测，未经考核者严禁上机。严禁未经允许进行 SOP以外的其他操作，或擅自修改

仪器硬件及软件设置、使用非指定部件，或在拆下安全装置的情况下操作仪器。

4.4.严禁在实验室的仪器电脑主机上使用 USB拷贝数据，严禁私自接入外部网络。

4.5.用户自主测试必须严格按照 SOP进行，实验过程中不得擅自离开实验室；实验室技

术员应经常巡视，及时纠正违规操作，消除安全隐患；实验结束后，整理好实验相

关区域并做好实验记录。

4.6.用户须在制样区完成制样工作，并保持工作区域整洁，相关工具放置在指定位置；

仪器操作区要保持整洁，相关工具和资料放置在指定位置；严禁摆放与实验无关的

个人物品；严禁在实验室饮食与抽烟。

4.7.禁止将自己的账号借给他人使用，尤其不可借给没有操作权限的人上机操作，一经

发现，直接取消使用资格。

4.8.严格遵守学校规章制度，有毒废物、试剂、器皿、利器等分类回收。

4.9.实验室人员离开前必须认真检查实验室的水、电、气是否关闭，离开时随手关门。

4.10.仪器操作过程中出现异响、异味、冒烟等异常现象时，请第一时间联系实验室技术

员。
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4.11.因违规操作或其他失误造成安全事故，相关责任人将受到通报批评及相应处罚。

5.实验室仪器设备管理规范

5.1.环境控制原子力显微镜 Cypher ES使用制度

该仪器遵从学校对大型仪器设备实行的管理办法和“集中投入、统一管理、开放公

用、资源共享”的建设原则，面向校内所有教学、科研单位开放使用；根据使用机时适

当收取费用；并在保障校内使用的同时，面向社会开放。

环境控制原子力显微镜 Cypher ES (以下简称环境控制 AFM)检测方案分为四类：

(1) 培训测试：用户提出培训申请，技术员安排培训。培训内容包括：实验室规章

制度说明、环境控制 AFM基本原理、硬件构造及各部分功能介绍；常规样品制样、仪

器的标准操作流程、控制软件(AR.16.11.212)操作、数据处理及测试注意事项。该过程中

用户在技术员指导下进行操作仪器并进行数据处理。

(2) 自主测试-初级：用户独立安装探针、制样、装样、独立操作环境控制 AFM，

进行气相接触、轻敲模式测试形貌、高度、粗糙度信息，并进行简单的数据处理及上传。

(3) 自主测试-中级：用户独立安装探针、制样、装样；独立操作 AFM除初级操作

外，进行液相、电学、力学的测试。

(4) 自主测试-高级：用户独立安装探针、制样、装样；独立操作 AFM除初级、中

级操作外的其他测试模式，包括原位测试以及根据用户的定制化需求设计实验方案进行

测试。

(5) 送样测试：用户预约时提供样品信息及测试要求；用户负责制样，技术员操作

仪器并做基本数据处理；

该仪器的使用实行预约制度，请使用者根据样品的测试要求在学校“大型仪器共享管

理系统”(以下简称大仪系统)进行预约，并按照要求登记预约信息。

5.2.预约制度

为充分利用仪器效能、服务全校科研工作，根据测试内容与时间的不同，实验室制

定了环境控制 AFM 7*24小时预约制度。根据预约制度可登陆大仪系统网站最少提前 2

小时预约机时，包括周末；国庆、春节假期等较长的假期，预约制度根据学校和平台要

求及时调整。

请严格遵守预约时间使用仪器，无故迟到、使用超时均属于违规，违规次数过多将

会通报或者禁用仪器（视情节严重情况进行处罚）。如需调换时间段，在技术员同意下
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可与其他使用者协商。因故不能在预约时间内测试者，请提前 2小时取消预约并通知技

术员。

(1) 校内使用者须经过技术员的实验操作培训，考核合格后方可上机使用；

(2) 实验开始时务必在实验记录本上登记，结束时如实记录仪器状态；

(3) 严禁擅自处理、拆卸、调整仪器主要部件。使用期间如仪器出现故障，使用者

须及时通知技术员，以便尽快维修或报修，隐瞒不报者将被追究责任，加重处理；

(4) 因人为原因造成仪器故障的(如硬件损坏)，其导师课题组须承担维修费用；

(5) 不可擅自做除培训操作之外的测试，如有需求请务必联系技术员；

(6) 环境控制 AFM 数据不允许在仪器电脑中删改，尤其不允许用 U盘与移动硬盘

直接拷贝。使用者应根据要求通过数据同步系统保存和下载原始数据至本地电脑；实验

数据在本实验室电脑中保留 2个月(暂定，根据情况若硬盘允许数据保存时间延长)。

(7) 使用者应保持实验区域的卫生清洁，测试完毕请及时带走样品，本实验室不负

责保管样品。

(8) 实验室提供镊子、螺丝刀、胶带、银胶等专用装针和制样工具，请合理使用，

用户不得私自带走。

(9) 使用者若违犯以上条例，将酌情给予警告、通报批评、罚款及取消使用资格等

惩罚措施。

5.3.培训考核制度

校内教师、研究生均可提出预约申请，由技术员安排时间进行培训，培训分为三部

分：

第一部分：由实验室技术员介绍实验室规章制度、安全管理规范、仪器设备原理、

基本硬件知识。

预约时段 预约时间/每人 测试内容

工作时间
周一至周五：

09:00至 17:30

每人次可预约机时≥30min

自主测试，送样测试

非工作时间

周一至周五：

18:30至次日 8:00

周末及节假日：09:00

至次日 8:00

自主测试
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第二部分：上机培训，内容包含：装针、制样、仪器标准操作规程、相应数据处理。

第三部分：上机培训结束后，培训者需根据实验安排，使用自己的样品进行预约上

机测试（建议两周以内），在技术员的监督下进行独立操作。待培训申请人觉得可以独

立操作后向技术员申请进行上机考核。

考核通过之后，技术员会给予培训者授权，培训者即可独立使用仪器，但仅限在其

用户级别所允许的可操作实验范围内使用。个别因为人为操作错误导致仪器故障者，除

按要求承担维修费用之外，给予降级重考惩罚、培训费翻倍。

注意：培训中的第一部分和第二部分需要用户在一周内完成(特殊情况除外)，否则需要重新进行

培训；培训通过后用户需保证每两个月至少 1次的自主上机测试，若超过该时间则需要重新联系仪

器负责人监督考核，否则将无法预约该仪器设备。考核不达标者需要重新申请培训，且培训费用是

初次培训的 1.5倍。

对接受培训人员的核心要求：

(1) 熟悉环境控制 AFM 原理、构造及各部分的功能，严格遵守仪器部件的开关顺

序，在突然停电时能及时处理并上报，关注仪器各部件有无异常；

(2) 熟练掌握环境控制 AFM 的原理及操作，严格按照标准操作规程操作，防止因

人为操作不当造成仪器故障，特别注意 holder 的安全使用、手动预下针操作、scanner

的安全操作，人为原因造成的仪器事故，所属课题组须承担维修费用，认真做好环境控

制 AFM的使用及故障记录。

5.4.仪器故障报告

(1) 仪器使用过程中，仪器出现故障及错误提示信息时，应即时通知技术员；

(2) 请在第一时间将故障及错误提示信息截屏，并保存在桌面“Error Report”文件夹，

截屏文件命名请按照“导师名-用户名-样品名-故障时间(具体到分钟)”；在《仪器设备使

用记录本》的备注栏做简单说明。

6.环境控制原子力显微镜 Cypher ES标准操作步骤

6.1.介绍

基本信息：环境控制原子力显微镜 Cypher ES主机（包括主体、光路系统、ARC2

控制器、ES扫描器，电脑及操作软件）；电学性能测试模块、高压 PFM模块、buleDrive

光热激发模块、扫描隧道成像模块、电化学液池模块。

仪器主要技术参数：
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扫描方式：样品扫描方式

XY方向最大扫描范围：30x 30μm

Z方向最大扫描范围：5μm

系统 XY方向闭环噪音水平：60pm

系统 XY方向开环噪音水平：8pm

系统 Z方向闭环噪音水平：15pm

环境控制系统：集成的环境控制扫描器,可密封

防泄漏压力传感器：有

气体控制：密封，可进行气体控制

温度控制：RT-250℃，可密闭环境中加热

自动化操作：自动化激光位置和检测器调零

快速扫描功能：最快扫描速度 128Hz，可在 1S内完成 1次扫描。常规扫描速度 20Hz

环境控制原子力显微镜 Cypher ES主要组成部分如下，如图 6-1所示：

图 6-1环境控制原子力显微镜 Cypher ES系统图示
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控制器/Controller：控制 XYZ三轴运动，收集数据等；

扫描器/Scanner：放置样品以及装好探针的 holder，扫描时 XYZ三轴分别有压电陶瓷控

制其运动，扫描范围 XY轴为 30μm，Z轴为 5μm；

背板/Backpack：相当于第二个控制器，内含 ADC/DAC等多种电学元件，是 Cypher 系
列可以实现低噪音水平以及快速扫描速度的关键因素。

扫描器/Scanner：

图 6-2 环境控制样品腔示意图

6.2.样品准备

测试样品要求干净，表面平整，高度起伏不要超过 5μm，最大尺寸直径小于 15mm，

高度小于 7mm。

6.3.探针准备

根据自己的样品准备合适的探针，如果是比较重要的样品，或者测试结果用于文章

发表，建议使用新的探针。

6.4.系统检查

测试前请完成如下检查：

(1) 测试前先确认 Controller的 Power灯亮，Laser钥匙位于 Off的位置。

如果不是该状态，请联系仪器负责人。
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图 6-3

(2) 装针前，选择正确的 holder，并检查 holder是否有异常，如裂痕、脏污等问题，

发现问题请及时告知仪器负责人。

6.5.制样

利用双面胶、导电银胶、AB胶将样品粘到样品托上，请将待测区域尽量放置在样品

托中心位置。制样前请检查样品托是否干净，务必要正反面都光滑干净没有残胶，否则

样品会无法移动。

警告：1. 制样时，需要确保待扫描的区域位于样品的最高点，更不要如下图 6-4 所示在样品托上放

置比样品高度更高的物体，一个样品托上只放置一个样品。

2. AFM的制样工具，样品托、镊子、螺丝刀均为实验室公共用品，请爱惜使用，不可带走。

3. 测试开始和结束后，需用无尘纸蘸取酒精认真清洁样品托的两面，并带走或者处理自己的样品，

不可一直占用公共样品托。

图 6-4

6.6.装针

用专用的探针镊子夹取探针 chip的中间部分，小心的放在 holder的压片下，大约压

在 chip的一半左右的位置，稍微拧紧压片的固定螺丝即可。
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警告：1. 装针前用氮气枪或者吸耳球认真吹扫 holder的压片和玻璃部分，确保没有 chip的碎片残留，

否则拧紧螺丝时可能会损伤玻璃。

2. 固定螺丝时，稍微拧紧固定探针即可，请勿过度用力，导致压片变形翘起，进而导致玻璃受力越

来越大，出现损坏。

3. 在手持 holder时，直接出 holder两侧的塑料部分，尤其注意不要用任何尖锐的物品碰到 holder表

面的铜线和芯片，否则可能导致 holder损坏，无法识别。

4. 务必拿稳 holder，不慎掉落造成玻璃损坏或 holder无法识别，需用户所在课题组赔偿。

6.7.装样品

（1）打开 AFM主机隔音罩的门，将 Scanner右侧的黑色把手抬起，轻轻将 Scanner

拉出。

注意：请勿将 Scanner拉出超过其侧面宽度的一半的距离，即中间螺丝处，以防其滑出隔音罩。

（2）用专用的镊子将样品放在样品台上，首先确认样品和 holder 之间有足够的距

离，不要在安装 holder的过程中撞到探针。如下图 6-5所示，将 holder上的两个孔隙分

别对准 Scanner上两根螺丝，轻轻向下压 holder，以压紧 holder上的橡胶 O圈，增强腔

体的密闭性，然后顺时针旋转 holder，将金色芯片插入槽内。在用螺丝刀分别拧紧两颗

螺丝。

图 6-5

警告：安装 holder过程中，撞到探针，不仅会损坏探针，还可能导致 holder损坏，请务必检查！

（3）将 Scanner推回初始位置，并将其右侧的黑色把手拉下，确认物镜的聚焦校正

环（图 6-6）对应在 1.5的位置，关上隔音罩。
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（4）肉眼观察探针和样品之间的距离，并小心缓慢的旋转 AFM主机上的旋钮，直

至探针下降至样品表面 2-3mm左右的位置。

图 6-6

警告：探针下降的速度随着旋钮扭动幅度的变大而变快，建议用户以小幅度来扭动旋钮，以防探针

撞到样品上，严重的情况下会损坏 holder和 Scanner。

注意：如果探针没有随着旋钮扭动而下降，可以尝试打开软件，初始化样品台：取下 holder，在 Engage

Panel中点击 Initialize Motor，后文会提到。

6.8.软件操作

（1）输入账号和密码，登录大仪系统，进入桌面。

在屏幕双击打开软件“AR16” ，打开控制器上的激光开关 Laser，从“off”旋到

“on”（以上两项顺序无固定要求）。等待软件下方进度条显示 Ready：

（2）选择测试模式。

在软件中弹出的“Mode Master” 窗口，选择“AC Air Topography”，进入轻敲模式的

软件环境：
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图 6-7

（3）初始化样品马达台

每次重新启动控制器时，系统会在 Engage Panel 自动提示初始化，点击“Initialize

Motor”按钮，图 6-8（如果没有重新启动控制器，则无此步骤）：

图 6-8

（4）找探针。
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如图 6-9所示，在“Video”窗口，利用上方的“Home”按钮和左上方标黄的 CCD按钮

寻找探针，点击 Home键之后，注意观察 Video窗口，应大致看到悬臂梁的轮廓，或者

可以判断出悬臂梁位于当前视场的哪个方向。之后在“Engage Panel”窗口中，上下调节

物镜焦距（请注意！要选择“Move Focus”才能调节物镜），单箭头为慢聚焦，双箭头为

快聚焦。确定针尖聚焦面后，点击“Focus On Tip“旁边的“SET”:

（5）下激光。

在针尖上点击右键，选择“Spot On”，此时，激光光斑应出现在相应位置，可以借助

左上角标黄的箭头调整激光的位置，按住 Shift键可以实现微调。

注意：激光调整原则：①尽量靠近针尖；②“Sum and Deflection Meter”窗口中，“Sum”

值尽量大，在 3以上；③不要漏光。

图 6-9

（6）找样品。
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继续向下调节聚焦，直至聚焦在样品表面上，点击 Focus on Sample 的右侧的 SET

按钮，此时可以看到 Sample Height的数值会更新。

（7）点击图6-9中标黑的“Move To Pre-Engage”按钮，这会使探针位于样品表面50μm

的位置。观察激光光斑是否有偏移，如果有可以微调其位置。

警告：如果前面设置的探针位置和样品高度错误的话，这一步很有可能会使探针撞到样品上发生损

坏！所以两个聚焦面设置好之后，请仔细检查一下！防止探针撞坏，甚至 holder再进一步撞到样品

上，造成更严重的设备损坏！

（8）点击“Sum and Deflection Meter”窗口的 Zero PD，使 Deflection调零（接近 0即

可）。

（9）寻峰/Tune，即寻找所用探针的共振频率并设置空气的 Free Amplitude值（Target

Amplitude），点击“Master Panel”窗口右侧栏的“Tune”按钮。

图 6-10
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“Cantilever Tune”窗口会弹出，点击“Auto Tune”按钮即可。

注：可以根据探针盒子上标明的频率范围，点击该窗口右侧的“Parms.”，手动修改 Auto Tune Low/High

的值，设备寻峰范围。

图 6-11

稍等片刻，可以观察到寻峰结果，寻峰得到的相关参数（Drive Amplitude 和 Drive

Frequency）会自动保存，此时可以关闭该窗口。

图 6-12
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（10）点击“Engage Panel”窗口中的“Start Tip Approach”按钮，开始自动下针，下针

成功后会有警示音发出。

图 6-13

（11）设置和优化扫描参数。

图 6-14

“Scan Size”：表示扫描图片的区域大小，Cypher ES的上限为 30μm；

“Points&Lines”：表示扫描是每行的扫描点数*扫描行数，请选择 256的倍数；
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“Scan Rate”：扫描速度，默认 2.44Hz，通常 40Hz以内均可；较软的样品，建议扫描速

度慢一些；

——以上三项参数，均根据实际的实验需求设置，还可以点击右侧栏中的“Parms.”，在

弹出的“Advanced Scan Parms”界面中，根据实际的实验需求进行更精细的设置。

“Setpoint”：默认 800mV，建议从 700~800mV开始，扫图过程中再进行调节；在轻敲模

式下，Setpoint和悬臂的自由振幅 Free Amplitude（即为 Auto Tune步骤中设置的 Target

Amplitude）的比值体现扫图过程中探针力的大小，所以 Setpoint的数值必须设置为小于

自由振幅 Free Amplitude的值。但是由于在通常 Auto Tune时，将自由振幅设为 1V，所

以可以近似理解为 Setpoint值越小，探针施加的力越大，反之亦然。为了保护探针，在

扫描过程中，建议调节至图片质量清晰时，值尽量大；

“Integral gain”：建议从 30开始，扫图过程中再进行调节；I gain值反映了系统反馈的灵

敏度，为了得到高质量的图像，在扫描过程中，建议尽可能增大，以提高灵敏度，直至

图像尚未产生噪音为止。

“Drive Amplitude”：表示压电陶瓷的驱动振幅，扫图过程中，如果调小 Setpoint依旧不

能得到满意的结果，可以增加该值，会增加探针的振幅，建议 Drive Amplitude和 Setpoint

同步调大，以保护探针。

——以上三项参数，在扫描过程中均为即时可调的，可以根据 Height图下方的红蓝两线

的重合情况即时调节。

图 6-15
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在“Master Channel Panel”界面的上方一栏或者在“Input”的下拉菜单中，可以选择想要设

置的图像数据频道（Height/Amplitude/Phase/ZSenor）。

“ColorMap”：可以选择图像颜色，在其下拉菜单中，点击一下“Setup”，可以获得更多颜

色选择。

Image Modification中，“Saved”选项中，对 Height选择“None”，以保存原始数据。

（12）在“Master Panel”界面，点击“Frame Up”或者“Frame Down”，很快就可以看见

各个图像出现，接下来精细调节 Set Point，Integral Gain，Scan Rate，根据 Height Image

下方的红蓝两线的重合情况即时调节，得到需要的高质量的图像结果。也可以随时选

择”Stop”，停止扫描。

注：轻敲模式下 AFM 会检测悬臂振幅的变化。随着探针向下移动，悬臂的振幅也会随之衰减， 当

其从 Free Amplitude 衰减到 Setpoint 时即认为下针成功。所以可以理解当我们加大 Drive

Amplitude（导致 Free Amplitude 加大），或者减小 setpoint 时，都会导致探针向下移动的距离 增

加，即探针与样品的距离变小。

Tips：

1 下针之前，根据 Video界面，初步确认想要测试的样品位置和范围

2 开始之后，检查一下“Sum and Deflection Meter”界面中的 Z Voltage的值，推荐在中间

区域，70-80左右，如果一直处于最大值（150），则说明之前下针未成功，需要停

止扫描“Stop”，减小 Setpoint重新下针，再开始。如果一直处于最小值（-10），这

说明之前样品表面定焦有问题，需要停止扫描“Stop”，点击“Move To Pre-Engage”，

增加 Setpoint重新下针，再开始。

3 如果扫描过程中想改变区域，停止扫描（“Stop”），点击“Pre-Engage”，再移动样品台，

切勿直接移动探针，有可能损坏探针！

（13）扫描过程中参数的调节

扫描过程中应观察 Height Retrace 窗口下的红蓝线是否重合，如果红蓝线完全重

合，表明此时 的扫描参数设置的合理，不需要进一步调节。

如果红蓝线并不重合，可以尝试如下几步：

~增加探针的力的大小，即减小 setpoint 或者增大 Drive Amplitude。

~增加反馈系统的灵敏度，即增大 Integral Gain值。注意：过大的 gain 值会引起系统震

荡，体现为图中出现明显波纹状噪音。

~降低扫描速率即 scan rate。
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~若仍不能使红蓝线重合，应考虑探针选择是否合理，或是否当前探针已经被污染或磨

损，尝试更换新的探针

（14）关于引力扫描和斥力扫描

在轻敲模式下，相位/Phase 值的大小可以反映探针和样品间作用力的类型，当

Phase< 90°时 处于斥力模式；而当 Phase> 90°时处于引力模式。

我们通常认为引力扫描时，由于探针并未“真正的敲击”在样品上，所以对于探针和

样品的保护性都很好，但牺牲了一定的图像分辨率。而斥力扫描则相反，往往可以得到

较为“清楚”的扫描图像，但是对于探针和样品也会多多少少有一点磨损。 我们可以根

据自己的样品来选择引力或斥力模式进行扫描，但注意一定要避免探针不断在引力与斥

力模式间跳动（mode hopping），即 Phase不断在 90°上下跳动。

下面我们会说明如何使探针在扫描过程中维持在更经常使用的斥力模式

~能否进入斥力模式，和探针、样品都有关系。

样品越黏，越软，有静电力，都会造成难以进入斥力模式。

探针越硬（k 值越大），越容易进入斥力模式。

探针越尖，越容易进入斥力模式。所以磨损的或者污染的探针，可能不容易进入斥力模

式。

~在扫描过程中调节参数从而进入斥力模式

通过增加 Drive amplitude 从而使探针的 free amplitude增大，越容易进入斥力模式。

设置的 setpoint越小，越容易进入斥力模式。

值得注意的是，之前谈到过扫描过程中探针上力的大小取决于 setpoint和 Free amplitude

的比值，所以在调节这两个值的时候需要保持这个比值大约在 50%~80%之间，即在逐

渐增大 Drive amplitude 的同时也逐渐增大 setpoint，直到 phase 稳定在小于 90°的范围

内。

6.9.数据处理及保存

（1）保存数据。扫完一幅图，软件会自动保存数据，默认保存在以当天日期命名的

文件夹中。建议选择需要的数据复制粘贴到自己课题文件夹中。存储路径：桌面/Asylum

Research Data/p-PI姓名/用户名/日期（每天新建）。
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（2）打开数据。方法一：点击菜单栏中的 AFM Analysis→Browse Save Data，在弹

出的 AR Load Path面板中，点击 Browse，选择数据所在文件夹，在弹出的 Browse面板

中，可以看到文件夹中的数据，如果要更改路径，点击 Browse面板的 Change Directory

按钮。

图 6-16

方法二：Browse面板中，双击图标就可以打开数据。如果想直接打开已有的数据 ibw

文件，首先打开 AFM软件，再把 ibw文件拖进去，最好不要用双击 ibw文件的方式打

开数据。

（3）数据后处理。点击图像上方的M按钮，打开Modify面板。

图 6-17

Modify面板最常用的功能是 Flatten和 Planefit，它们的作用是拉平形貌图像（Height

高度图和 Z Sensor图），Flatten和 Planefit一般不用于形貌图之外的图像。
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图 6-18

Planefit 是将形貌图整体调平，消除图像的倾斜。选中所要处理的图像和通道，

Planefit Order选择1，点击XY（代表Planefit作用于图像的X和Y方向）。1阶和Histrogram

Planefit最常用，0阶只消除 offset，用处不大，2阶可能改变形状，慎重使用，请根据

最终图像的消除倾斜的效果选择。

图 6-19

Flatten是将 AFM 的扫描线逐一对齐。Flatten是逐行调平、对齐，类似于对每条线

分别做 Planefit。选中所要处理的图像和通道，选择合适的 Flatten Order，点击 Flatten，

如果效果不好，可点击 Undo Flatten。1 阶和 Histrogram Flatten 最常用，0 阶 Flatten 可

以对齐线，也会用到，2阶可能改变形状，慎重使用。
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图 6-20

以上对图像的处理（Flatten，Planefit），都只对内存中的数据生效，硬盘中保存的

数据不受影响。重启软件后打开数据，依然是处理之前的样子，要保存对图像的处理，

可以选择 Commands下拉菜单的 Save Image（覆盖原数据），或者 Save As …（数据另

存为）

图 6-21

对图像进行后处理（Flatten，Planefit）之后，都可通过点击 Restore Layer或者 Ultra

Restore Layer恢复原始数据，不必担心保存更改后回不去。

（4）图片颜色和对比度调节。在数据中的 ColorMap下拉菜单可以选择颜色表，点

击 Auto可以自动调节颜色的显示，利用 Range / Offset 可以手动调节颜色的显示。
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图 6-22

（5）导出图片或数据。

~选中图像，菜单栏 File→Save Graphics，在 Format选择导出的格式（一般选择 TIFF格

式）， 点击 Do It，设置导出的名称和路径。

~点击图像上方的 Ly按钮，也可以将图像复制到 Layout（类似一个剪贴板），除了图像，

截面线、直方图、Mask等元素也可以保存到 Layout，Layout可以通过菜单栏 File→Save

Graphics或者 Print Layout保存为图片或 PDF报告。Layout中的元素也可以被复制粘贴

到 Office软件中。

~AFM 图像是一个个数据表格，数据可以导出，在数据图片的 Commands下拉菜单，选

择 ASCII Export，即可保存为 txt格式。

~对于形貌图（高度图和 Z Sensor图），软件也可以生成 3D图像，点击图像上方的 3D

按钮，就会生成 3D图像。鼠标左键旋转模型，右键改变光照角度。3D图像不能用 Save

Graphics导出，要用菜单栏 Edit→Export Graphics导出。

（6）数据分析。

数据分析的功能主要在 Analyze面板，点击图像上方的 A按钮，打开 Analyze面板。
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图 6-23

常用的数据分析工具有 Roughness（粗糙度等统计值）和 Section（截面线）。

~Roughness页面给出形貌图的统计信息。Sdev [Rq]和 Adev [Ra]常用来描述粗糙度；Max

/ Min：数据点中的最大值/最小值；Avg：数据点的平均值；Area：样品表面积；Area %：

样品表面积相比扫描范围多出来的比例；Volume：样品体积，相对于 Z = 0平面

图 6-24

~Section用来读取图像在一条线上的数据。对于形貌图来说，就像做了一个截面。点击

Draw，在图像上画一条线，出现截面线，拖动两个光标可以改变线的位置，点击 Clear
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可以删除截面线。Mode有两种，Line（直线）和 Free Hand（自由轨迹）；在 Line直线

模式下勾上 Full，截面线贯穿图像；在 Line直线模式下勾上 Angle方框，输入角度值，

可以限定线的角度；增大Width，截面线变宽，有平均的效果，数据可能更平滑；

图 6-25

截面线窗口的下方是 Cursor工具栏。 Cursor工具栏可以通过键盘的 Ctrl+I隐藏或

显示，用鼠标把 Cursor拖到曲线上，就可以得到那一点的 X和 Y数值。用两个 Cursor，

还可以知道它们的 X差值和 Y 差值。在截面线窗口点击 Edit，会出现数据表，可以保

存为 csv文件或复制到别的软件；

图 6-26
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6.10.实验结束

扫描结束后，点击 Engage Panel 中的(Un)Load Sample 退针，取下探针，收起样品，

关上激光并关上软件，退出大仪系统，收拾桌面和制样区，在实验记录本上做好使用登

记。无需关闭控制器和电脑。

7. 相关/支撑性文件

7.1 Q/WU FLHR001 文件编写规范

8. 记录

8.1 环境控制原子力显微镜 Cypher ES V1.0
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仪器设备使用记录本 20 年

日期
月.日

测试人 导师（PI） 样品名称、状态及数量
实验内容

（Contact/AC/CAFM/PFM/Forc
e Curve……）

检测方式
使用时间 备注

送样 自主

请注意：(1) 使用前先检查仪器状况，一切正常方可操作；一旦开始实验，默认为使用前仪器及各个配件状况良好；(2) 使用过程中出现故障须立即联系技术员；测试

后请及时取回样品;
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	2.固定螺丝时，稍微拧紧固定探针即可，请勿过度用力，导致压片变形翘起，进而导致玻璃受力越来越大，出现损坏
	3.在手持holder时，直接出holder两侧的塑料部分，尤其注意不要用任何尖锐的物品碰到holder
	4.务必拿稳holder，不慎掉落造成玻璃损坏或holder无法识别，需用户所在课题组赔偿。
	6.7.装样品
	（1）打开AFM主机隔音罩的门，将Scanner右侧的黑色把手抬起，轻轻将Scanner拉出。
	注意：请勿将Scanner拉出超过其侧面宽度的一半的距离，即中间螺丝处，以防其滑出隔音罩。
	（2）用专用的镊子将样品放在样品台上，首先确认样品和holder之间有足够的距离，不要在安装hold
	图6-5
	警告：安装holder过程中，撞到探针，不仅会损坏探针，还可能导致holder损坏，请务必检查！
	（3）将Scanner推回初始位置，并将其右侧的黑色把手拉下，确认物镜的聚焦校正环（图6-6）对应在
	（4）肉眼观察探针和样品之间的距离，并小心缓慢的旋转AFM主机上的旋钮，直至探针下降至样品表面2-3
	图6-6
	警告：探针下降的速度随着旋钮扭动幅度的变大而变快，建议用户以小幅度来扭动旋钮，以防探针撞到样品上，严
	注意：如果探针没有随着旋钮扭动而下降，可以尝试打开软件，初始化样品台：取下holder，在Engag
	6.8.软件操作
	（1）输入账号和密码，登录大仪系统，进入桌面。
	在屏幕双击打开软件“AR16”，打开控制器上的激光开关Laser，从“off”旋到“on”（以上两
	（2）选择测试模式。
	在软件中弹出的“Mode Master” 窗口，选择“AC Air Topography”，进入轻敲
	图6-7
	（3）初始化样品马达台
	每次重新启动控制器时，系统会在Engage Panel自动提示初始化，点击“Initialize M
	图6-8
	（4）找探针。
	如图6-9所示，在“Video”窗口，利用上方的“Home”按钮和左上方标黄的CCD按钮寻找探针，点
	（5）下激光。
	在针尖上点击右键，选择“Spot On”，此时，激光光斑应出现在相应位置，可以借助左上角标黄的箭头调
	注意：激光调整原则：①尽量靠近针尖；②“Sum and Deflection Meter”窗口中，“
	图6-9
	（6）找样品。
	继续向下调节聚焦，直至聚焦在样品表面上，点击Focus on Sample的右侧的SET按钮，此时可
	（7）点击图6-9中标黑的“Move To Pre-Engage”按钮，这会使探针位于样品表面50μ
	（8）点击“Sum and Deflection Meter”窗口的Zero PD，使Deflect
	（9）寻峰/Tune，即寻找所用探针的共振频率并设置空气的Free Amplitude值（Targe
	图6-10
	“Cantilever Tune”窗口会弹出，点击“Auto Tune”按钮即可。
	图6-11
	稍等片刻，可以观察到寻峰结果，寻峰得到的相关参数（Drive Amplitude和Drive Fre
	图6-12
	（10）点击“Engage Panel”窗口中的“Start Tip Approach”按钮，开始自
	图6-13
	（11）设置和优化扫描参数。
	图6-14
	“Scan Size”：表示扫描图片的区域大小，Cypher ES的上限为30μm；
	“Points&Lines”：表示扫描是每行的扫描点数*扫描行数，请选择256的倍数；
	“Scan Rate”：扫描速度，默认2.44Hz，通常40Hz以内均可；较软的样品，建议扫描速度慢
	——以上三项参数，均根据实际的实验需求设置，还可以点击右侧栏中的“Parms.”，在弹出的“Adva
	“Setpoint”：默认800mV，建议从700~800mV开始，扫图过程中再进行调节；在轻敲模式
	“Integral gain”：建议从30开始，扫图过程中再进行调节；I gain值反映了系统反馈的
	“Drive Amplitude”：表示压电陶瓷的驱动振幅，扫图过程中，如果调小Setpoint依旧
	——以上三项参数，在扫描过程中均为即时可调的，可以根据Height图下方的红蓝两线的重合情况即时调节
	图6-15
	在“Master Channel Panel”界面的上方一栏或者在“Input”的下拉菜单中，可以选
	“ColorMap”：可以选择图像颜色，在其下拉菜单中，点击一下“Setup”，可以获得更多颜色选择
	Image Modification中，“Saved”选项中，对Height选择“None”，以保存
	（12）在“Master Panel”界面，点击“Frame Up”或者“Frame Down”，很
	注：轻敲模式下 AFM 会检测悬臂振幅的变化。随着探针向下移动，悬臂的振幅也会随之衰减， 当其从 F
	（13）扫描过程中参数的调节
	扫描过程中应观察 Height Retrace 窗口下的红蓝线是否重合，如果红蓝线完全重合，表明此时
	如果红蓝线并不重合，可以尝试如下几步：
	~增加探针的力的大小，即减小 setpoint 或者增大 Drive Amplitude。 
	~增加反馈系统的灵敏度，即增大Integral Gain值。注意：过大的gain值会引起系统震荡，体
	~降低扫描速率即scan rate。
	 ~若仍不能使红蓝线重合，应考虑探针选择是否合理，或是否当前探针已经被污染或磨损，尝试更换新的探针 
	（14）关于引力扫描和斥力扫描
	在轻敲模式下，相位/Phase 值的大小可以反映探针和样品间作用力的类型，当 Phase< 90°时
	我们通常认为引力扫描时，由于探针并未“真正的敲击”在样品上，所以对于探针和样品的保护性都很好，但牺牲
	下面我们会说明如何使探针在扫描过程中维持在更经常使用的斥力模式 
	~能否进入斥力模式，和探针、样品都有关系。
	样品越黏，越软，有静电力，都会造成难以进入斥力模式。 
	探针越硬（k 值越大），越容易进入斥力模式。 
	探针越尖，越容易进入斥力模式。所以磨损的或者污染的探针，可能不容易进入斥力模式。
	~在扫描过程中调节参数从而进入斥力模式 
	通过增加Drive amplitude 从而使探针的free amplitude增大，越容易进入斥力
	设置的setpoint越小，越容易进入斥力模式。 
	值得注意的是，之前谈到过扫描过程中探针上力的大小取决于setpoint和Free amplitude
	6.9.数据处理及保存
	（1）保存数据。扫完一幅图，软件会自动保存数据，默认保存在以当天日期命名的文件夹中。建议选择需要的数据复制
	（2）打开数据。方法一：点击菜单栏中的AFM Analysis→Browse Save Data，在弹出的
	图6-16
	方法二：Browse面板中，双击图标就可以打开数据。如果想直接打开已有的数据ibw文件，首先打开AF
	（3）数据后处理。点击图像上方的M按钮，打开Modify面板。
	图6-17
	Modify面板最常用的功能是Flatten和Planefit，它们的作用是拉平形貌图像（Heigh
	图6-18
	Planefit是将形貌图整体调平，消除图像的倾斜。选中所要处理的图像和通道，Planefit Or
	图6-19
	Flatten是将AFM的扫描线逐一对齐。Flatten是逐行调平、对齐，类似于对每条线分别做Pla
	图6-20
	以上对图像的处理（Flatten，Planefit），都只对内存中的数据生效，硬盘中保存的数据不受影
	图6-21
	对图像进行后处理（Flatten，Planefit）之后，都可通过点击Restore Layer或者
	（4）图片颜色和对比度调节。在数据中的ColorMap下拉菜单可以选择颜色表，点击Auto可以自动调节颜色
	图6-22
	（5）导出图片或数据。
	~选中图像，菜单栏File→Save Graphics，在Format选择导出的格式（一般选择TIF
	~点击图像上方的Ly按钮，也可以将图像复制到Layout（类似一个剪贴板），除了图像，截面线、直方图
	~AFM图像是一个个数据表格，数据可以导出，在数据图片的Commands下拉菜单，选择ASCII E
	~对于形貌图（高度图和Z Sensor图），软件也可以生成3D图像，点击图像上方的3D按钮，就会生成
	（6）数据分析。
	数据分析的功能主要在Analyze面板，点击图像上方的A按钮，打开Analyze面板。
	图6-23
	常用的数据分析工具有Roughness（粗糙度等统计值）和Section（截面线）。
	~Roughness页面给出形貌图的统计信息。Sdev [Rq]和Adev [Ra]常用来描述粗糙度
	图6-24
	~Section用来读取图像在一条线上的数据。对于形貌图来说，就像做了一个截面。点击Draw，在图像
	图6-25
	截面线窗口的下方是Cursor工具栏。 Cursor工具栏可以通过键盘的Ctrl+I隐藏或显示，用鼠
	图6-26
	6.10.实验结束
	扫描结束后，点击 Engage Panel 中的(Un)Load Sample 退针，取下探针，收起
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